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1. Introduction
Congratulations and thank you for buying NTI’s Acoustilyzer AL1, a 
product specially suited for professional acoustical test applications. The 
Acoustilyzer offers advanced acoustics functions including an optional 
speech intelligibility STI-PA measurement module and further basic 
electrical features. We are convinced you will enjoy using it!

This manual describes the Acoustilyzer AL1 functions and measurements 
in detail. Further application information about the acoustical and electrical 
measurements can be found on the web site “www.nti-audio.com”.

The Acoustilyzer AL1 is available as stand alone test instrument or as 
crossgrade package for existing Minilyzer ML1 users. The same crossgrade 
option can be used to install the Minilyzer functionalities on the AL1. The 
STI-PA measurement feature is optional.

The product packages include the following items:

Acoustilyzer AL1 1x Acoustilyzer AL1
1x MiniLINK CD (PC software)
1x MiniLINK USB Cable
1x Acoustilyzer Test CD 
1x Acoustilyzer User Manual

ML1-AL1 Crossgrade 1x MiniLINK CD (PC software)
1x Acoustilyzer Test CD (audio samples)
1x License Number Crossgrade
1x Acoustilyzer User Manual
1x Minilyzer User Manual

STI-PA Measurement 
Option

1x STI-PA Test CD (STI-PA test signal)
1x License Number STI-PA
1x Acoustilyzer User Manual

www.nt-instruments.com
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CE Declaration of Conformity

We, the manufacturer 

     NTI AG
     Im alten Riet 102
     9494 Schaan
     Liechtenstein, Europe

hereby declare that the product Acoustilyzer AL1, released in 2004, 
conforms to the following standards or other normative documents.

EMC-Directives:   89/336, 92/31, 93/68
Harmonized Standards: EN 61326-1

This declaration becomes void in case of any changes on the product 
without written authorization by NTI. 

Date:      1. September 2004

Signature:   

Position of signatory: Technical Director
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International Warranty and Repair

International Warranty
NTI guarantees the functionality of Acoustilyzer AL1 against defects in 
material or workmanship for a period of one year from the date of original 
purchase, and agrees to repair or to replace at its discretion any defective 
unit at no cost for either parts or labor during this period.

Restrictions
This warranty does not cover damages caused through accidents, misuse, 
lack of care, the attachment or installation of any components that were 
not provided with the product, loss of parts, connecting the instrument to 
a power supply, input signal voltage or connector type other than specified 
or wrongly polarized batteries. In particular, no responsibility is granted for 
special, incidental or consequential damages.
This warranty becomes void if servicing or repairs of the product are 
performed by any party other than an authorized NTI service center or if 
the instrument has been opened in a manner other than specified in this 
manual.
No other warranty, written or verbal, is authorized by NTI. Except as 
otherwise stated in this warranty, NTI makes no representation or warranty 
of any kind, expressed or implied in law or in fact, including, without 
limitation, merchandising or fitting for any particular purpose and assumes 
no liability, either in tort, strict liability, contract or warranty for products.

Repair
In case of malfunction, take - or ship prepaid - your NTI Acoustilyzer 
AL1 packed in the original box, to the authorized NTI representative 
in your country. For contact details see the NTI web page  
“www.nti-audio.com”.

Make sure to include a copy of your sales invoice as proof of purchase 
date. Transit damages are not covered by this warranty.

www.nt-instruments.com
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Warnings

In order to avoid any problems during the operation of the instrument, follow 
the rules listed below:

•	 Use	the	instrument	for	the	intended	purpose	only.

•	 Never	connect	the	instrument	to	a	high	voltage	output	such	as	
a	power	amplifier,	mains	power	plug,	etc.

•	 Do	not	disassemble	the	instrument.

•	 Never	use	the	instrument	in	a	damp	environment.

•	 Remove	the	batteries	as	soon	as	they	are	flat	or	if	the	instrument	
is not intended to be used for a longer period of time.

Test	&	Calibration	Certificate

This is to certify the Acoustilyzer AL1 is fully tested to the manufacturer’s 
specifications. NTI recommends to calibrate this test instrument  
one (1) year after purchase. Thereafter the calibration- and adjustment 
interval is subsequently one (1) year.
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2. Overview
The Acoustilyzer AL1 is a sophisticated 
tool used to analyze acoustical signals. 
It is designed for easy and quick detailed 
analysis of the acoustic environment 
and to carry out the most important 
electrical measurements. An accurate 
overview of the actual acoustical signal 
is displayed on a large LCD.

The AL1 is a class 1 accuracy instrument 
and available with the measurement 
microphones MiniSPL (class 2) or 
M2010 (class 1 frequency response). 
Alternatively other measurement 
microphones can be used.

Class 1 acoustics analyzer
NTI offers the class 1 frequency response 
microphone M2010 (an external 
phantom power supply is required). 
The Acoustilyzer in combination with 
the M2010 measurement microphone 
forms a highly accurate class 1 
acoustics analyzer.

Class 2 acoustics analyzer
The Acoustilyzer in combination with 
the MiniSPL forms a comprehensive 
class 2 acoustics analyzer. MiniSPL 
is a battery powered measurement 
microphone. It is the ideal accessory for 
the Acoustilyzer.



8 9

Acoustilyzer Functions

The Acoustilyzer AL1 features many 
measurement functions, which are 
accessible through a drop down menu bar. 

The base element is the cursor (inverted 
area), which may be navigated through the 
various functions by using the cursor keys.

• SPL/RTA: Sound pressure level & time-averaged sound pressure 
level (LEQ) measurements of wideband, octave or 1/3 
octave values

• RT60: Reverberation time with 1/1 octave band resolution

• FFT: Real time zoom FFT

• POLARITY: Polarity measurement of speakers and line signals

• DELAY: Delay time measurements between speakers

• RMS/THD: Level and distortion measurements

• STI-PA: Speech intelligibility measurement (only visible after 
received STI-PA license activation key)

• CALIBRTE: Calibration of connected measurement microphone

Easy Operation

Unit selected with cursor to 
change setting

All selectable settings may be adjusted 
simply by 
• Pressing the enter key to select the 

requested value.
• Alternatively at longer selection lists the 

chosen field is flashing. Now select the 
requested value with the cursor keys. 
Confirm the setting by pressing the 
enter key again.
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Connectors

On top of the AL1, three connectors as well as the internal microphone are 
located:

• The XLR and RCA inputs allow to feed a signal to the AL1.  
We recommend to use the XLR input for best performance (minimum 
noise floor and best dynamic range). In case a measurement 
microphone with unbalanced output is used, this shall be connected 
to the XLR-input, between pin 2 and 3.

• A 3.5 mm (1/8“) jack monitor output allows the connection of a 
headphone. Thus, the user may hear any electrical input signal.

• The internal microphone is used to test the polarity of loudspeakers 
and for delay time measurements. SPL measurements are not 
supported with this internal microphone.

XLR & RCA 
Inputs

Monitor 
Output

Internal 
Microphone

Note: Never connect the XLR- and the RCA input at the same time!
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Battery Replacement

After unpacking, insert three (3) pcs. 1.5 V alkaline batteries, type AA, LR6, 
AM3 into the AL1 battery compartment as shown below. The typical life-
time for a set of alkaline batteries is 16 hours.

         

Notes:
•	 We	do	 not	 recommend	 to	 use	 rechargeable	NiCd-	 or	NiMH-

batteries.
•	 Do	not	insert	batteries	of	different	types.
•	 Replace all batteries at the same time - never mix old and new 

batteries.
•	 Note	the	correct	polarities	of	the	inserted	batteries.
•	 Remove	 the	batteries	as	soon	as	 they	are	flat	and	change	all	

batteries at the same time.
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3. Basic Operation
In spite of the wide range of available measurement functions and optional 
setups, the operation of the Acoustilyzer is almost self-explanatory.

Menu Bar

Test Result

Power On/Off- 
Backlight

Escape 
button

Enter / Cursor 
Keys

The LCD is divided in the menu bar on top and the measurement results 
displayed below.

The cursor keys and the escape button allow straightforward navigation 
through the available features

•	 Actual settings (measurement function, filters)

•	 Measurement results (numerical or graphical display)
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Start-up Screen

The start up screen remains displayed by 
pressing and holding any button during the 
start up of the unit. This supports e.g. the 
read out of the instrument serial number 
from your device. The serial number 
starts with three letters (such as e.g. 
ANK675A2A2).

After the successful registration of the AL1 
the start-up screen may be customized. 
See details in “Customizing start-up screen” 
later in this user manual.

Menu Bar
The menu bar allows the selection of the basic test configurations.

Measurement 
Functions

Screen 
Selector

Memory Menu 
& Battery Status 
Indication 

Input 
Filters

Setup 
Screen
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Measurement Functions

• SPL/RTA: SPL & RTA measurement
• RT60:   Reverberation Time 
• FFT:   Real time zoom FFT
• Polarity:  Speaker polarity 
• Delay:  Delay time 
• RMS/THD: RMS level and distortion
• STI-PA:  Speech intelligibility 
• Calibrte:  Calibration menu

Screen Selector

The Acoustilyzer features the SPL/RTA, 
RT60 and STI-PA function with two different 
test result screens.

e.g. the SPL/RTA “123” is showing the 
sound level meter screen and the marked 
graphical symbol shows the real time 
spectrum analyzer.

Short-cut
Hold the ESC button down and additionally 
press the left or right arrow key to switch in-
between the two display screens within the 
same measurement menu.
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Input Filters

Depending on the selected measurement functions the following sets of 
filters are available:

SPL/RTA function:

Filters Applications

FLAT
Flat frequency response  
(no filtering)

Overall sound pressure level, all 
sound signal components are included 
without weighting, required for special 
applications;

A-WTD 
A-weighting filter acc.  
IEC 61672

Applicable for most common sound 
pressure levels if level weighting following 
the human ear is required.

C-WTD
C-weighting filter acc.  
IEC 61672

Applicable for high sound levels if level 
weighting following the human ear is 
required. Verify the filter setting with the 
test specifications.

X-CRV-1 

Inverted X-Curve filter acc. 
ISO 2969

Required for cinema installations

RLB (=Revised Low 
frequency B-curve)
Broadcast Loudness filter 
acc. AES Paper “Loudness 
Assessment of Music and 
Speech” 2004

Applicable for loudness measurement 
of broadcast material. The revised B-
weighted Leq measurement (=RLB) 
correlates the best to the subjective 
experience by humans.
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RMS/THD	function:

Filters Applications

FLAT
Flat frequency response  
(no filtering)

Default measurement setting.

A-WTD 
A-weighting filter

Measuring residual noise of the unit 
under test acc. IEC 61672 e.g. in sound 
broadcasting applications.

C-WTD
C-weighting filter acc.  
IEC 61672

Special applications.

HP400
Highpass 400 Hz acc. DIN 
45045, -120dB/dec.

Removes any mains frequency (50/60Hz) 
components from the test signal.

HP19k
Highpass 19 kHz

Removes any low frequency components 
from the test signal, e.g. to measure any 
20kHz pilot tone level of critical public 
announcements systems.
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Setup Screen

The setup screen allows to customize basic 
settings of the Acoustilyzer AL1 by the 
following procedure:
• Move the cursor to the corresponding 

field and press the enter key.
• Select the required status by using the 

arrow keys.
• Press the enter key to confirm.

AUTO POWER OFF defines the time the AL1 is switched OFF automatically 
after the last key-press. The available settings are 3 MIN, 10 MIN, 30 
MIN, 60 MIN and DISABLE. In case DISABLE is selected, the user 
has to turn the unit off manually or it will run until the batteries are 
discharged.

 Acoustilyzer operation with MiniLINK PC Software
During the operation of the AL1 with the MiniLINK PC software, the 
AL1 is powered from the PC and the following power saving functions 
are disabled:- Auto Power Off - Auto Light Off. After the PC software 
MiniLINK is switched off the Acoustilyzer is continuously further powered 
from the PC but the power saving features are enabled again.

AUTO	LIGHT	OFF defines how long the backlight stays on after any key 
stroke. Possible selections are 3 SEC, 10 SEC., 60 SEC. and DISABLE. 
In the latter case, the backlight will stay on, until the unit is switched off. 
The longer the backlight is turned on, the shorter lifetime of the batteries 
will be.

LCD CONTRAST adjusts the contrast of the display. Alternatively, hold the 
ESC button down and press the up/down arrow key simultaneously in 
any measurement panel.

MULTIPLE SETUP allows to store up to four individual settings. To enable 
the multiple setup mode, set the corresponding entry to ENABLE and 
confirm. At the next time the Acoustilyzer is switched on, the user will 
have to select the individual setup-ID (1, 2, 3 or 4) in the startup screen. 
All parameter settings in all measurement modes are now stored under 
this ID at switch off.
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Memory Menu & Battery Status Indication

All measurements can be stored into the 
internal instrument memory. Each record is 
saved with a file name consisting of the test 
mode and a continuous running number 
from 000 - 999, such as “A001_RMS_THD” 
or “A002_RT60”. The running number starts 
after 999 with 000 again.
You can store the test results as follows:

•	 STORE+BMP
Saves the numeric test results including 
the graphical screenshot, indicated 
by BMP (=bitmap) in the memory 
overview.

•	 STORE
Saves the numeric test result, so 
occupying less memory space.

•	 VIEW	+	DELETE
The stored measurement results are 
listed in ascending order from bottom to 
top, so the latest recorded measurement 
is always on top of the list. The remaining 
memory space is displayed in the right-
upper corner of the screen.
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All screenshots marked with BMP can be 
reviewed directly on the instrument.

• Select any record in the list using the 
cursor.

• Press and hold the enter key.

• The recorded measurement is displayed 
on the instrument screen

• The selected record is marked in the 
memory menu by the full square in the 
front. You can recall the marked record 
at any time later by holding down the 
ESC button and pressing the enter key 
simultaneously.

Delete individual memory records
Each stored result can be deleted 
individually from the memory.

• Select the DEL field beside the memory 
location to be deleted.

• Confirm OK within the pop up window 
and press the enter key.

• The memory location is deleted from the 
device memory.

Delete all memory records
The complete memory can be deleted by 
selecting the field “DEL ALL“.
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LOAD
Various Acoustilyzer functions support 
the test result data loading from the 
internal AL1 memory. This features is very 
useful for detailed test result read out of 
previously stored measurements on the 
test instrument.

The following measurements support this 
feature:
• SPL/RTA
• RT60
• FFT
• STI-PA

Note: Any ongoing measurement is 
continuing during loading and 
reading a memorized test result.

Application example using SPL/RTA:
• Select LOAD in the memory menu and 

press enter.
• The possible memorized data for loading 

are displayed.

• Select the test result of interest.
• Confirm the selection with the enter 

key → the square symbol in front of the 
selection is filled up.

• Press the ESC button (cursor jumps to 
OK) and confirm with enter.
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The loaded test result is displayed on the 
active AL1 screen and the abbreviation 
LOD is flashing in the status bar memory 
field.

The individual band levels can be read 
out, the Y-axis altered or even the Leq or 
min/max. test result shown. Non-available 
functionalities are not selectable.

Return back to the live mode by selecting 
LIVE MODE in the memory menu of the 
upper menu bar.

Low battery indication
A low battery symbol is displayed in the 
“MEM” field of the menu bar to indicate that 
a change of batteries is required.



22 23

4.  Measurement Functions

Overview

Function
Test 

Result 
Screens

Test Features

SPL/RTA Sound Level Meter
Sound pressure level SPL, MAX/MIN SPL, 
LEQ, LcPEAK
Real Time Analyzer
1/1 and 1/3 octave real time spectrum analyzer
showing SPL, MAX/MIN SPL & LEQ per band

RT60 Reverberation Time
in octave band resolution based on T20 results
Reverberation Time
detailed test results listed in seconds including 
correlation factor

FFT Real-time Zoom FFT
POLARITY Polarity Test

of acoustical speaker or electrical line signals 
DELAY Delay Time

Propagation delay measurement between 
electrical reference and acoustical signal

RMS/THD Electrical Measurements
Level RMS, THD+N, Frequency

STI-PA Speech intelligibility
of public announcement systems in STI or CIS 
test results (only visible after received STI-PA 
license activation key)
Speech intelligibility
Individual LEQ and STI-PA modulation indices 
of test frequency bands

CALIBRTE Calibration Menu
for external measurement microphones, 
sensitivity set by default to NTI MiniSPL
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SPL/RTA - Sound Level Meter

The Acoustilyzer features a comprehensive, integrating sound level meter 
with timer for single or repeated measurements. All results may be logged 
into the internal memory for further investigations. 

The measurements displayed on the big and small result position may be 
altered between
 
 • SPL  Actual sound pressure level 
 • MIN SPL  Minimum sound pressure level

• MAX SPL  Maximum sound pressure level
 • LEQ   time-averaged sound pressure level 
 • PreLEQ   LEQ of the previous timer period (only available
    when timer is in repeat mode

• LcPEAK:  C-weighted peak sound pressure level

The included Timer allows automatically to
• Stop the LEQ, LcPEAK and MAX/MIN SPL measurements after a 

user defined time
• Reset the LEQ, LcPEAK and MAX/MIN SPL measurements after a 

user defined time to start a new measurement.

Time Weighting 
indicator / selector

Timer 
Status

Pause Measurement 
Timer, Clock

Reset Test Cycle 
Period

SPL Bargraph and range 
indication

Input Range 
indicator arrows

Big Result

Small 
Result
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Test Applications: “Timer Status” Setting

TIMER OFF
(applicable for standard measurements) 
All values are recorded and monitored 
continuously. The measurement timer 
shows the actual testing period length. 
Pressing the RESET icon sets the clock 
and the test results back to zero.

TIMER SINGLE
Sound pressure level measurement with 
user defined time setting. 
• Set the required test cycle period.
• The clock counts back to zero. After the 

defined test time is completed the clock 
is flashing as”00.00.00”. 

• The test results LEQ, LcPEAK and 
MAX/MIN SPL are frozen.

• Changing the test cycle period setting 
or pressing the RESET icon restarts the 
measurement.

TIMER REPEAT
Automatically repeating measurements 
with user-defined test time interval. 
• Set the required test cycle period. 
• The measurement timer counts back to 

zero. When the test time is elapsed the 
clock and the test results are reset and 
a new measurement is started.

• The previously measured LEQ is 
displayed as PreLEQ (very useful for 
LEQ monitoring at concerts)

• Changing the test cycle period or 
pressing the RESET icon restarts the 
measurement.
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Pause: The LEQ, LcPEAK and MAX/MIN measurements can be paused
 • Select the PAUSE symbol and press the enter key.

• The PAUSE symbol is flashing.
• The actual SPL value is continuously measured and displayed.
• Select the pause symbol and press the enter key to continue the 

measurement, visible by the continuing counting clock.

Reset: Pressing the RESET icon restarts the measurement. The timer and 
test results are reset.

Test Cycle Period: Applicable in SINGLE and REPEAT timer status only.
• SINGLE: Set to 10 min by default
• REPEAT: Set to 10 sec by default

Measurement Timer: Actual measurement in hours:minutes:seconds.

Big and Small Result: Two of the previous listed measurements may be 
display at the same time.

Time Weighting: All SPL measurements (SPL and MAX/MIN SPL) 
are time weighted measurements. Changes in the SPL level are 
smoothed resulting in quicker or slower change of the displayed value.  
Available time weightings, corresponding to IEC 61672, are

• SLOW  (long  attack- and release response time, t = 1s)
• FAST  (short attack- and release response time, t = 125ms)

The time weighting for the broad band values ( ) and the RTA ( ) 
are always the same.

Overload

The OVL (Overload) is flashing if the 
input voltage exceeded the selected 
input range of the instrument. As long as 
the OVL is flashing the displayed LEQ 
and LcPEAK result is not accurate.
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Input Range Selector & Bargraph
 

In the SPL/RTA Mode the AL1 has three measurement ranges. The span 
of each range depends on the sensitivity of the used microphone. For a 
MiniSPL with a sensitivity of 20mV/Pa the measurement ranges are:

 
  20 to 100 dB  40 to 120 dB  60 to 140 dB

 
The selected input range is displayed at the bottom of the bargraph and 
may be changed by operating the range indicator arrows. The bargraph 
provides an analog display of the actual sound pressure level. 

Primary Indicator Range 
 To achieve best measurement accuracy the appropriate range 

must be selected, called “primary indicator range”. Correct setting 
avoids overflow indications and lowers the influence of noise on the 
measurement result. 

 The two range indicator arrows assist the user to set the optimal range. 
As soon as the indicated bargraph value is found lower than the primary 
indicator range, the down arrow symbol below RNGE will start to move, 
symbolizing the actual SPL measurements are inaccurate. The bargraph 
range needs to be changed manually by selecting the moving left arrow 
symbol and pressing the enter key.

Note: Changing the ranging resets all ongoing measurements.

By exceeding the primary indicator 
range three overload arrows replacing 
the big result reading. 
• Select the right arrow below RNGE 

and press enter to change to the next 
higher bargraph range. 
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SPL/RTA - Real Time Analyzer RTA

The Acoustilyzer sound level meter features the individual 1/3rd or full 
octave band test results using class 0 filters. The SPL, MAX / MIN and LEQ 
values are displayed per band.

Stored spectra may be averaged by using the available mathematical 
functions. The MAX-MIN display is particularly helpful for characterizations 
of listening areas.

Input Range 
indicator arrows

Audio 
Spectrum

Set 
Menu

Pause Reset Cursor 
Readout

X-Axis with manual 
range selection

Y-Axis

The audio spectrum is displayed without interrupting any ongoing sound 
level measurements, so e.g. changing from  to  screen will not 
interrupt the ongoing sound level measurements. 

Input Filter
The SPL/RTA input filter for the broad band values ( ) and the RTA ( ) 
may be selected independently - so e.g. a FLAT RTA is available while the 
broad band values are acquired using an A weighted filter. Please note that 
only various filter combinations are possible. 

Note:	 Changing	filter	settings	re-starts	the	ongoing	measurement.
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Set Menu

The SET menu allows for particular 
measurement settings and display options 
as listed below:

RES - Resolution
Select 1/3rd octave or full (1/1) octave band 
resolution by pressing the enter key.

SHOW	-	Test	Result
The actual SPL, MAX/MIN SPL and LEQ 
can be displayed per band.

The actual SPL is displayed with filled 
bars. 

The LEQ spectrum is displayed with framed 
bars.

The MAX/MIN SPL range is displayed with 
filled bars. The cursor read out shows either 
the maximum, the max-min difference or 
the minimum sound pressure level of the 
selected band.

Simply toggle through these results with 
upper & lower arrow keys:

 - max. SPL
 - min. SPL
 - max. - min. SPL
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TWTD - Time Weighting
Applicable for the actual sound pressure 
level measurement. The available response 
times, corresponding to IEC 61672, are

• SLOW (long attack- and release time)
• FAST (short attack- and release time)

The time weighting for the broad band 
values ( ) and the RTA view ( ) are 
always the same.

HOLD	-	Cursor	Hold
The cursors indicates the band of highest 
sound pressure level. For simple read out 
and traceability the cursor can remain for  
1 - 9 seconds at the frequency band with 
the highest level. This may e.g. support 
finding of feedback frequencies.

Cursor Readout: Actual level result in the indicated frequency band.  
The cursor readout displays the center frequency and the level of the 
band pointed to by the arrow. The cursor automatically jumps to the 
highest level band in the spectrum.

 
Alternatively the cursor readout may be controlled manually:
• Select the read out data field and press the enter key.
• A frame is flashing around the data readout.
• Move the cursor and read the corresponding test results.

Pause / Reset / Input Range Indicator / TWTD - Time Weighting:
 These controls are exactly the same as found on the sound level 

meter screen and also effect both, the RTA and the sound level meter 
measurement (e.g. pressing PAUSE in the RTA screen also pauses the 
broad band LEQ, LcPEAK and MAX/MIN SPL measurements).

. 
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X-Axis: Logarithmic scale fixed to 20 Hz - 20kHz

Y-Axis: The scaling of the spectrum’s Y-axis (sensitivity) can be adjusted 
manually.
• Select the displayed upper value of Y-axis and press the enter key.
• Use the up/down keys to scroll the displayed level along the Y-axis 

and the left/right keys zoom in/out the Y-axis, e.g. to alter the display 
resolution.
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SPL/RTA - Memory Functions
The SPL/RTA mode includes special memory features, such as in

SPL/RTA - Sound Level Meter
• LOGGING: records the measured parameters to the internal device 

memory every time the log interval ∆t has expired (in table form).

SPL/RTA - Real Time Analyzer RTA
• LOAD: loads stored test results into the active AL1 display for 

detailed read out.
• MATH: completes mathematical averaging of various stored 

measurements selected from the memory.

Logging
The Acoustilyzer can record various levels over time, e.g. for monitoring 
sound levels during an event for many hours, into the instrument memory. 
Every time the recording interval ∆t is elapsed the results are stored and 
values marked with “_dt” are reset afterwards. The logging may stop 
automatically after the preset measurement time has elapsed. The results 
can then be loaded to a PC and visualized as a level diagram using e.g. 
Microsoft Excel. 

Note:  The stored results remain within the AL1 memory even in the 
event of a battery failure during the recording session.

The following parameters are recorded during the logging.

LEQ   Leq over the whole measurement period. The measurement 
period is indicated and controlled by the measurement timer.

PreLEQ  Leq of the previous measurement timer period (in timer repeat 
mode only).

LEQ_dt  Short time LEQ of the actual log interval ∆t. LEQ_dt values 
may be combined to get the LEQ of any desired period:
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MIN_dt  Minimum SPL value measured within the actual log interval ∆t; 
time weighted value (SLOW/FAST).

MAX_dt  Maximum SPL value measured within the actual log interval ∆t; 
time weighted value (SLOW/FAST).

Example of an SPL/LEQ log visualized with Microsoft Excel  
(without LcPEAK)

LcPeak  Maximum C weighted peak sound pressure level during the 
whole measurement period. The measurement period is 
indicated and controlled by the measurement timer.

LcPeak_dt Maximum C weighted peak sound pressure level during the 
log interval ∆t.

SPL_Act  Indicates the actual SPL level measured exactly at the end of 
the log interval. Please note that LEQ_dt, MIN_dt and MAX_dt 
characterize an interval more accurate than this single 
SPL_Act value.
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Example of an SPL/LEQ log visualized with Microsoft Excel
(LcPEAK only)

OVER_dt  A “1” indicates an overload during the log interval ∆t (so all 
values tend to be measured to low).

OVER_Hold A “1” indicates an overload during the measurement period.

UNDER_dt A “1” indicates an underload during the measurement period  
(so all values tend to be measured to high).

  
Prepare Logging
Select LOGGING from the Memory Menu. 
This will bring up the Logger Setup Screen:
 
Setting of recording time
The maximum recording time (END) of the 
sound pressure level logging depends on 
the remaining memory and the selected 
test interval (∆t). The logger may record 
a maximum of about 580 points over a 
custom defined time.  The test interval (∆t) 
and the total logging time can be defined by 
the user in the format hh:mm:ss.
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Note: During SPL/RTA logging the 
instrument may be switched to 
display the audio spectrum. This 
is possible without interrupting 
the ongoing log.

Review logging records
The measurement data are saved under 
the file name “Axxx_LOGSPL”, with xxx is 
a continuous running number. The detailed 
records can be read out by using the 
MiniLINK PC software.

LOAD - Loading Test Results

For details see the earlier chapter “Memory 
Menu”.
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MATH	-	Mathematical	Averaging	of	Records

The MATH function allows to carry out  
averaging of stored test results.

Application example:
• The available previously memorized 

data for averaging are displayed.
• Make your selection with the enter key 

→ the square symbol in front of the 
selection is filled up.

• Select any number of test results for 
averaging.

• Press the ESC button (cursor jumps to 
OK) and confirm with enter.

The averaged test result is displayed on 
the active AL1 screen and the abbreviation 
MAT is flashing in the status bar memory 
field.

The individual band levels can be read out, 
the Y-axis altered or even the LEQ or MIN/
MAX test result shown.

• Return back to the live mode by selecting 
LIVE MODE in the memory menu.



Reverberation Time RT60

The Acoustilyzer supports reverberation time measurements in octave 
band resolution according to ISO3382 with auto trigger, auto ranging and 
averaging functionality.

What is Reverberation Time RT60
Reverberation time RT60 is the time required for the sound pressure level 
to decrease 60 dB after the sound stimulus signal is stopped. Since ambient 
noise often defeats measurements of 60dB level decrease in practice, the 
RT60 results are based on T20 measurements. This requires only a 35 
dB level decrease within each octave band. The RT60 test result is the 
extrapolation of the measured 20 dB decay. 

Test Signal
A gated pink noise signal is recommended to be used as test signal. Various 
test tracks with different on/off time are included on the accompanying AL1 
Test CD. Alternatively the Minirator features the required gated pink noise 
signal.

a. Bargraph display

Octave Bands 

Start Pause Measurement  
Status

Individual Octave 
Band Spectrum

RT60 Upper Mark 
Indicator

RT60 Lower Mark 
Indicator

X-Axis,
level with 
10 dBSPL 
marks

Number 
of Test 
Results 
taken for 
automatic 
averagingRanging, 

initial record of 
environmental 
noise prior 
measurment

Octave 
bands scroll 
63Hz - 8kHz

36
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b.	How	to	measure

The room under test is injected with a pink noise signal through speakers. 
The sound source has to be active until balance between injected and 
absorbed acoustical energy has been reached. Then the source signal has 
to be stopped. The AL1 recognizes this interruption, triggers, the decay 
time is measured and the RT60 test result is automatically calculated. 

Please follow the RT60 test instruction below:

Ranging 
• Select RANGE and press the enter key 

to measure the actual sound pressure 
level in the room without test signal 
present.

• The SET RANGE field pops up. Confirm 
the automatic ranging by OK.

Now the RT60 upper mark indicators are 
set to the minimum pink noise level needed 
to successfully complete a measurement. 
The lower marks indicate the environmental 
noise without any test signal present.
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• Start the pink noise test signal with the 
appropriate on/off time according the 
room under test.

Note: Use an initial low sound pressure 
level (to protect your ears against 
excessive sound level and hearing 
damages).

• Increase the test signal level until all 
individual octave band marks for the 
minimum test signal level are passed. 
As required an EQ can be used to push 
up individual band levels.

Start RT60 measurement
• Select the START icon and press the 

enter key to initiate the reverberation 
time measurement.

• The status indication switches to 
ARMED.

• Complete several test cycles so an 
averaged test result is calculated. 

• The individual octave band sound 
pressure level increases above the 
upper marks.

• Upon the sound pressure level has fallen 
below the lower marks in each individual 
octave band the RT60 is calculated. 

• Switch off the test signal.

Confirmation marks are displayed for 
successful octave band reverberation time 
measurements.
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Test result read out
The detailed RT60 test results in  
x.xx seconds are listed in the RT60 test 
result screen. Select the detailed test result 
read out screen by 
• Using the screen menu
• Alternatively press the ESC and the left 

or right arrow key simultaneously.

Note: Dur ing  the  ongo ing  RT60 
measurement the memory menu 
is not available.

c. RT60 Test Result Read Out

Test Result 
in seconds

Correlation Factor in %
or Measurement Uncertainty

Relative Test 
Result, displayed as 
bargraph

Test Result 
Selection

Number of 
continuously 
taken test 
results

Delete selected 
Test Result

Start Pause

Octave 
bands scroll 
63Hz - 8kHz

Test Result Selection: The RT60 measurement function enables 
consecutive reverberation time measurements within one test 
sequence. Automatically an averaged test result of all measurements 
is calculated.
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Toggle with the left and right AL1 cursor keys through the individual test 
result cycles and you can find the following:

Last test result
The test result of the last test cycle is 
displayed at selection LAST. 
You can use the upper and lower AL1 
cursor keys to display the 63 Hz or 8 kHz 
octave band test result additionally.

Single test cycle results
The individual single test results are 
marked with CYC xx, whereby xx is a 
continuous running number.

Averaged test result
By selecting AVRG the averaged test 
results of all taken measurements 
are calculated and displayed. The 
correlation factor is replaced by the 
measurement uncertainty factor in %. 

Relative	Test	Result,	displayed	as	bargraph:	To simplify the data read 
out the reverberation time is additionally displayed as bargraph, whereby 
the octave band with the longest measured reverberation time is shown 
with a bargraph of maximum length. The other octave band test results 
are displayed relative to the longest time.

Correlation
Factor in %

Correlation Factor in %
(applicable for single test results)
This factor will be 100% for perfect linear 
sound pressure level decay after the 
source is switched off. Deviations from 
linearity result in lower correlation values.  
(typically 80 - 100% at reliable RT60 test 
results).
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Uncertainty 
Factor in %

Uncertainty Factor in %
(applicable for averaged test result)
Based on at least three individual 
test results, the uncertainty factors 
are calculated. This factor equals the 
statistical test result accuracy based on 
the randomly created pink noise test signal  
(typically 0 - 15% at reliable RT60 test 
results). Please see the standard ISO 3382 
for details.

Error Indications

Delete single 
test results

Various error indications display non 
successful RT60 measurements, These  
can be deleted individually. Non-valid results 
are excluded from average calculations.

•	 LOW	LEVL
This is the abbreviation of “low test 
signal level” during the measurement 

→ Increase the test signal level and 
verify that all levels are exceeding the 
upper marks

→ Use a corresponding RT60 test signal 
with longer on/off times, so the lower 
level mark can be reached

•	 CORR<70%
The correlation factor is lower than 70% 
indicating a unreliable measurement 
result.

•	 T>18S
The measured reverberation time 
exceeds the time limit of 18 seconds, 
e.g. caused by a not suitable ranging or 
environmental noise.

In this case repeat the ranging and start 
the measurement again.
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FFT Analysis

The Acoustilyzer includes an extremely fast, real-time Zoom FFT with 
resolutions up to 0.7Hz over the entire frequency range. The display shows 
93 bins simultaneously. 

The FFT measurement is the ideal tool for visualization of comb filters and 
narrow band effects. It allows a detailed investigation of the frequency 
response of audio systems.

FFT Audio 
Spectrum

Set 
Menu

Pause Cursor 
Readout

Start Frequency 
of Display

Y-AxisEnd Frequency 
of Display

Size of displayed  
Frequency Range

Set Menu

The SET menu allows the setting of 
measurement- and display options as 
follows:
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Range - AL1 Input Ranging
The Acoustilyzer has different input 
ranges. 
• The range is set automatically at 

entering the FFT mode
• Carry out the input ranging if any clipping 

or high noise occurs

SHOW	-	Test	Result
Select the display of actual SPL or averaged 
sound pressure level (=LEQ). The LEQ 
measurement can be reset by executing 
the range setting or at the new selection of 
SHOW: LEQ.

HOLD	-	Cursor	Hold
The cursor indicates the frequency of high-
est sound pressure level. For simple read 
out and traceability the cursor can remain for  
1 - 9 seconds at the frequency with the 
highest level.

Pause: The FFT measurement may be frozen for a user defined time.
• Select the PAUSE symbol and press the enter key.
• The PAUSE symbol is flashing.
• Select the PAUSE symbol and press the enter key to continue the 

measurement.

Cursor Readout: Actual level result of the indicated frequency bin.  
The cursor readout displays the bin-frequency and the corresponding 
level. The cursor automatically jumps to the highest level in the spectrum. 
Alternatively the cursor readout may be controlled manually:
• Select the read out data field and press the enter key.
• A frame is flashing around the data readout.
• Move the cursor and read the corresponding test results.
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X-Axis: Linear scale, showing from left to right the start frequency, the 
frequency range and the end frequency by 92 bins with zooming 
functionality.

Y-Axis: The scaling of the Y-axis can be adjusted manually.
• Select the displayed upper value of Y-axis and press the enter key.
• Use the up/down keys to scroll the displayed level along the Y-axis 

and the left/right keys zoom in/out the Y-axis, e.g. to alter the display 
resolution.

How	to	measure:

• Select the FFT function. The cursor 
read out shows the maximum level 
automatically.

• Select the cursor read out field and 
confirm with enter. A frame is flashing 
around the read out data. 

• Read out other values using the left or 
right arrow keys.

Zoom in/out to cursor position
• Select the cursor read out field.
• Use the lower arrow key to zoom in up 

to a 0.7 Hz frequency resolution and the 
upper arrow key to zoom out.

• Move the x-axis by left/right key press.

Zoom	in/out	with	quick	X-axis	shifting
• Select the x-axis frequency range field
• The zoom in/out functionality refers to 

the displayed center frequency.
• Use the left/right arrow key for quick left/

right shifting of the x-axis.
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Application: FFT and White Noise

White noise is most often used as test signal when measuring the 
performance of acoustical systems. The FFT shows a flat spectrum with 
this input signal. Feeding white noise into an electro acoustic system and 
measuring the FFT using a measurement microphone shows the frequency 
response of the system with very high resolution. 

Please note that the frequency response seen is most often a combination 
of two effects:

a) The “real” frequency response of the electronics and speakers
b) Interference effects (resulting in comb filtering)

With a high resolution FFT interference effects can easily be seen - while 
they are nearly impossible to notice on a 1/3 octave resolution RTA.

The Zoom FFT of the AL1 allows to “Zoom In” at any frequency point to a 
resolution of up to 0.73 Hz. 

4 x zoom →
level reduces 
by 6 dB

White Noise and Zooming
The energy of “White Noise” is equally 
distributed over the linear frequency axis. 
Let’s assume we have a White Noise signal 
with a level of 0 dB measured using a 
bandwidth of 20 kHz. 

What happens if we decrease the 
measurement bandwidth to 10 kHz? 

→ We only measure one half of the energy – 
resulting in a level of -3 dB (10*log10(0.5)).

This is exactly what happens if we  
“Zoom In” using an FFT. Every time we 
“Zoom In” the measurement bandwidth is 
halved – resulting in a 3 dB lower level in 
every bin.
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Polarity Test

The polarity test function detects the correct cable and speaker polarity in 
combination with the Minirator MR1 polarity test signal. The Acoustilyzer 
provides the following test configurations:

a.	Speaker	Polarity	Test

• Feed the speaker system with the 
polarity test signal of the Minirator.

• Adjust the level (at MR1 or amplifier) so 
the test signal is good to hear.

Acoustilyzer settings:

• IN:MIC (INT), using the internal mic of 
the Acoustilyzer AL1

• IN:XLR/RCA, using an external mic, 
such as the MiniSPL

Choose the polarity test frequency range:

• FULL/MID, for wide band speaker tests

• WOOFER, for woofer tests

Notes:
•	 Please	note	the	polarity	testing	is	a	simplified	measurement	of	a	

very	complex	signal	phasing.	Drivers,	speakers	and	cross-overs	
cause severe phase shifts of the audio signal.

•	 The	polarity	of	various	speakers	within	 the	same	cabinet	can	
be	different.	This	is	not	a	problem	nor	caused	by	bad	speaker	
design.

•	 Polarity	testing	is	useful	for	checking	the	correct	wiring	of	similar	
speaker	systems.
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b. Cable Polarity Test

Use the polarity test signal of the Minirator to 
feed the cable under test. The Acoustilyzer 
analyzes the signal polarity at the other end 
of the cable.

Acoustilyzer settings:
• IN: XLR/RCA, 
• Mode: Cable

The	following	problems	may	be	detected	quickly	and	easily:

• Wrong polarity, caused by wrong or defective wiring inside the cable

• Cable problems, unsymmetrical signals, displayed with the balance 
indicator, can help to detect various cable problems, such as

“2UBAL–”   indicates an audio signal only on pin 2 of the symmetrical 
XLR cable → no signal at pin 3.

“-UBAL3”    indicates an audio signal only on pin 3 of the symmetrical 
XLR cable → no signal at pin 2.

The balance indicator out of center leads to other cable problems as 
explained in detail in the NTI application note “Signal Balance“ (available 
for download at the NTI website).

The level measurement is very useful for applications, such as testing of 
multicore cables (see the NTI website for application notes).
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Delay Time

The setting of the acoustics propagation delay time from speaker to speaker 
in e.g. churches or auditoriums, is required so the listening public notices 
the acoustics of the speaking person from his actual position and not from 
the side or rear speaker installed.

The Acoustilyzer measures the delay time of the acoustical speaker signal 
(using the built-in microphone) against the electrical line reference signal 
(connected at RCA or XLR input). As delay time test signal a designated 
chirp, provided on the AL1 Test CD, has to be used.

Converted 
Delay Time in 
meter/feet

Delay Time 
Memory

Automatically calculated Delay Time 
Store - Actual

Start Synchronization Synchronization Time Bar
100% = 100 seconds

Actual 
measured 
Delay Time 
to Electrical 
Reference 
Signal

Status Indication

Synchronization: The automatic synchronization allows delay time 
measurements without any connected electrical reference signal for  
100 seconds and displays the time remaining for the next required 
synchronization.

Manual Synchronization: 
Initiate a manual synchronization by selecting SYNC.
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How	to	measure
Note:	 Please	 de-activate	 any	 shock	

protection of the CD-player since 
this might cause incorrect test 
results!

Test preparations
• Switch on the acoustical delay time 

measurement signal, available on the 
AL1 Test CD. 

• Connect the electrical signal, e.g. from 
the CD player, to the AL1 RCA or XLR 
input.

• Wait until the Acoustilyzer synchronizes 
to the incoming delay time test chirp and 
the synchronization time bar fills up to 
100%.

The delay time measurement is conducted 
between the synchronized electrical input 
signal and the built-in microphone of the 
Acoustilyzer.

Measure	Reference	Speaker
• Select a speaker as reference speaker, 

called speaker A, e.g. the speaker most 
in front of the delay line.

• Position yourself in the sound field of 
the next speaker under test, e.g. called 
speaker B, to measure the delay time 
compared to the reference speaker A.

Note: Do not position the Acoustilyzer to 
close	to	reflecting	surfaces,	such	
as	walls	or	floors.	The	reflections	
may interfere any accurate 
measurements.



50 51

Change  
[m][°C] ↔ [feet][°F]

• Enable the test signal at the reference 
speaker A. All other speakers shall be 
switched off.

• The delay time of the acoustical signal in 
reference to the electrical input signal is 
displayed in milli-seconds. The distance 
results in meter/feet are displayed for 
easy verification of the test results. The 
readings are based on 330 m/s sound 
speed at 0°C / 32°F.

• Set the actual environment temperature, 
so the distance is displayed correctly.

Store reference
• Select STORE to memorize this test 

result as reference record for further 
delay time measurements.

• The stored reference delay time is 
shown in the delay time memory field.

Measure	Propagation	Time	at	Speaker
• Enable the test signal at the speaker B. 

All other speakers shall be switched off.
• The acoustical delay time of speaker B 

in reference to the electrical input signal 
is displayed as big test result.

Automatic Time Difference Calculation
• The delay time difference is automatically 

calculated and shown in the upper small 
STO-ACT (stored - actual) field. 
The automatic difference calculation 
simplifies the verification of delay line 
arrangements, e.g. used in larger halls 
or auditoriums.
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Electrical	Measurements	-	RMS/THD

The Acoustilyzer supports basic electrical measurement functions,  
such as
• Level RMS, reflects the absolute level of the line input signal.
• THD+N, Total Harmonic Distortion plus Noise, besides checking the 

linear purity of a sine signal - e.g. measuring the amount of harmonic 
distortions - this mode is particularly suited to get a quick idea whether 
unwanted interferences like hum are present.

Distortion 
THD+N

Signal 
Frequency

Signal Balance 
Indicator

Level RMS 
Result and Unit

 

Level RMS: The units dBu, dBV, dBSPL and V are selectable.

Distortion	THD+N: The distortion measurement, expressed in dB or in %, 
is carried out in the bandwidth 10 Hz - 20 kHz.
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Signal Balance shows the matching deviation of the incoming signal 
between pin 2 and pin 3 in percent (%). The arrow position indicates the 
following:

• Arrow in center, the input signal is balanced.

• Arrow out of center, linear indication of a balancing problem, e.g. 
arrow moves left nearer to the number 2 shows the signal level on 
pin 2 is higher than on pin 3.

• Arrow at left or right end, the signal balance error is 33% or higher. 
33% equals a difference in the signal level of 6 dB.

• 2UBAL-, indicates an audio signal only on pin 2 of the symmetrical 
XLR cable → no signal at pin 3.

• -UBAL3, indicates an audio signal only on pin 3 of the symmetrical 
XLR cable → no signal at pin 2.

Notes:
•	 The	Adapter	 -20dB	shall	 be	applied	 for	balanced	 input	 levels	

higher	than	+20	dBu	(see	Accessories	for	details).
•	 The	THD+N	results	are	calculated	using	a	measuring	bandwidth	

of	10	Hz	-	20	kHz.
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Speech Intelligibility STI-PA (optional)

The speech intelligibility measurement STI-PA is an optional sales package 
for the Acoustilyzer AL1. Ask your local representative for purchasing 
details.

The STI-PA analyzer option allows reliable measurement of the speech 
transmission index within 15 seconds. Besides the single value STI or CIS 
test result, a detailed view of the modulation indices and individual band 
level results is provided. The STI-PA analyzer fulfills the latest 2003 IEC 
60268-16 standard and is a TNO verified algorithm (dutch STI-PA research 
institute).
Find more information about speech intelligibility basics and the historical 
developments in the APPENDIX to this user manual.

a. STI-PA Measurement Screen

Actuall 
Sound 
Pressure 
Level

Measurement Progress Bar 
(0..15 seconds)

Analogue STI-PA Bargraph 

STI-PA 
Test 
Result

Start 
Measurement

Measurement 
Status 
Indication

STI-PA Test Result: Single value speech transmission index result in 
STI (speech transmission index) or CIS (common intelligibility scale), 
whereby CIS is calculated as CIS = 1 + log STI.

Sound Pressure Level: Shows actual SPL value in dBAS, including  
A-weighting and Slow time weighting.
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b.	How	to	measure

• Select the STI-PA function. 
• Monitor the actual sound pressure level 

of your environment on the Acoustilyzer 
display.

Preconditions:
• To avoid measurement failures the  

STI-PA test signal level should be  
min. 60 dBSPL.

• The STI-PA measurement should be 
carried out at emergency conditions 
(same sound pressure level and all 
components are activated). 

• No impulsive noise events should occur 
during the 15 seconds measurement 
time.

NOTE: Even intermediate noise may 
affect the STI-PA test result.

Signal Source:
The NTI	 TalkBox can simulate a human 
talker, enabling the measurement of the 
complete system including the microphone 
part (directivity, room characteristics, ...). 
Place the NTI TalkBox at the typical human 
speaker position.

The Minirator MR-PRO or a CD Player 
(with the NTI CD “STI-PA V1.1” or higher) 
can be used for electrical signal injection for 
system tests without the microphone part.
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• Start the STI-PA test signal.
• Set the acoustical sound pressure level 

of the PA system according the typical 
emergency condition requirements, e.g. 
85 dBAS.

• Press START on the AL1 menu to 
initiate the measurement. Near the 
measurement microphone is no 
speaking or additional noise allowed 
during the measurement.

A STI-PA measurement takes 15 seconds. 
The elapsed test time is visible as blank part 
in the upper measurement progress bar.

The test result tendency is shown on the 
below STI-PA bargraph, marked with BAD, 
PR (poor), FR (fair), GD (good) and EXLT 
(excellent).

After the 15 seconds test cycle time the 
Measurement Status Indication switches to 
FINISHED and the final STI-PA test result 
is displayed.

On the bargraph below the quality of the 
speech intelligibility test result is displayed 
as

• BAD     0.00 - 0.30 STI
• PR (poor)   0.30 - 0.45 STI
• FR (fair)    0.45 - 0.60 STI 
• GD (good)   0.60 - 0.75 STI
• EXLT (excellent) 0.75 - 1.00 STI
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The detailed test result view of the 
modulation indices and individual band 
level results is provided on the second  
STI-PA measurement screen.

c. Detailed Test Result Read Out

STI-PA 
Octave Bands 

Individual Octave 
Band LEQ Level 

STI-PA Modulation 
Index 2

STI-PA Modulation 
Index 1

Error 
Detection 

STI-PA Modulation Index 1 & 2: 
For high speech intelligibility it is mandatory that the integrity of the 
transmitted voice signal modulations are preserved. Therefore STI-PA is 
based on measuring the MTF (Modulation Transfer Function). This function 
quantifies the degree to which the voice modulations are preserved in 
individual octave bands. STI-PA determines the MTF by analyzing all seven 
frequency bands, whereby each band is modulated with two frequencies, 
so resulting in the modulation index 1 and index 2 
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d. STI-PA Post Processing

Measuring speech intelligibility index under realistic environment conditions 
is often not applicable, e.g. playing the test signal in a railway station at 
emergency levels during peak hours will irritate passengers. Additionally 
at rush hours the characteristics of back ground noise might be highly 
impulsive. But a prerequisite for accurate STI-PA measurements is a 
negligible impulsivity in the background noise.

Under such circumstances the STI-PA measurement should be shifted to a 
more suitable time of the day, e.g. night time. Such STI-PA measurements 
taken at untypical background noise conditions have to be post-processed. 
Post processing combines the STI-PA measurement data taken at quasi 
noise-free ambient conditions with the unweighted octave band noise levels 
(Leq) taken e.g. during day time, at realistic environmental conditions.

The NTI STI-PA Post Processing Software is exactly tailored for this 
application e.g. to combine the night and day-time measurement.
 

“STI-PA_PostProcessing.xlt” is available
• For download at “www.nti-audio.com”, Products: Acoustilyzer
• On the CD “MiniLINK - PC Software”

Note: At opening the post processing sheet all macros have to be 
activated. 

http://www.nt-instruments.com/acoustilyzer
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e. STI-PA Error Detection

The Acoustilyzer STI-PA measurement function has a built in error detection 
which helps you identifying faulty measurements. The error detection 
checks the following parameters:

•	 Invalid modulation indices (MF1 or MF2 > 1.3) 
•	 Irregularities during ongoing measurements

Both parameters depend on the amount of impulsive environmental noise. 
Impulsive environmental noise influences any STI-PA measurement and 
makes the values inaccurate.

If the error detection finds any problem the 
common STI-PA test result is displayed 
interrupted with the flashing “?.??” question 
marks. 

This error indication might be caused either 
by
• Missing test signal level
• Impulsive background noise events

Detailed test result screen
The octave bands detected with 
irregularities, are marked with a question 
mark (?).

Recommendation
If the error detection finds any faults NTI 
recommends to repeat the measurement 
and to compare the STI test result with the 
previous ones.
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f.	STI-PA	Measurement	Hints

1. Any background noise has to be sufficiently static during the 
measurement, e.g. pink noise fulfills this requirement.

2. Verify the environmental conditions prior testing. Complete STI-PA 
measurements without any test signal. The results shall be < 0.20 STI.

3. Impulsive background noise during the measurement, such as speech, 
causes severe measurement errors. The STI-PA result is usually too 
high.

4. In case such impulsive noise can not be prevented, the measurements 
might be shifted e.g. to night time, and afterwards corrected with the 
averaged daily background noise, using external post processing.

5. Any CD-Players used to reproduce the STI-PA test signal have to be 
accurate as only limited time-shifts (+/- 200 ppm) are allowed to 
ensure reliable STI-PA test results. Pitch control and shock protection 
shall be disabled. NTI recommends using professional players only.
You may verify the time shift of your CD-Player with a 9 kHz test signal: 
•	 Generate a 9000 Hz sine signal using the NTI Wavefilegenerator 

(available for download at the NTI-website -> Acoustilyzer) and copy 
this on a CD

•	 Insert this CD into the CD player and play the 9 kHz test signal
•	 Connect the Acoustilyzer to the audio output directly and measure 

the signal frequency in the RMS/THD mode, the displayed frequency 
shall be in the range from 8998 to 9002 Hz (the last digit equals  
111 ppm at 9 kHz)

6. The STI-PA test signals of other test system manufacturers may sound 
similar but are not compatible. Only the NTI STI-PA test signal CD V1.1 
or higher shall be used in combination with the Acoustilyzer AL1.

7. STI-PA measurement of alarm systems shall be carried out at 
emergency conditions (same sound pressure level and all components 
are activated).

8. At locations undergoing different circumstances, e.g. public areas with 
few people or crowded areas, the worst case STI-PA results has to be 
measured.

9. Select typical locations, such as positioning the microphone 
at 1 - 1.2 meters above ground in sitting areas or 1.5 - 1.8 meters 
in standing areas (typical measurement positions are normally not 
directly in front of the speakers)
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10. The person taking the measurements should be out of the acoustic 
field, so not affecting the measurement results. For this purpose 
the measurement microphone can be mounted on a mic stand and 
connected electrically (using an extension audio cable) to the AL1.

11. Low STI-PA readings can be caused by
•	 Excessive sound reverberation, echoes or reflections
•	 Poor speaker directivity or speaker coverage
•	 Speaker power setting not in order (e.g. low signal-to-noise ratio)

Please see the NTI website or Appendix for further information.
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Calibration

In order to obtain correct measurement results the microphone sensitivity 
connected to the AL1 must be set and calibrated accordingly. The microphone 
sensitivity is set by default to the NTI MiniSPL measurement microphone factory 
adjustment 20mV/Pa. MiniSPL is the standard measurement microphone 
for the Acoustilyzer AL1.Together they are forming a comprehensive class 
2 acoustics analyzer. 

Alternatively to the MiniSPL the NTI M2010 class 1 frequency response 
microphone can be used for highly accurate class 1 measurements.

Microphone 
Sensitivity

Microphone Balance Indicator, 
arrow has to be centered to verify 
the balanced mic input singal

Default 
Factory Setting

Manual Calibration with 
external microphone calibrator

The following three calibration modes are available:

DEFAULT
All MiniSPL microphones are factory 
calibrated to a sensitivity of 20.0 mV/Pa. 
Reset to default setting by:

• Select DEFAULT
• Press the enter key
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CALIBRATE 
The sensitivity may be adjusted with an 
external calibrator.
• Select the dBSPL value field (default 

= 114 dBSPL), press the enter key 
and adjust the sound pressure level 
as provided by your calibrator. Use up/
down keys for 1.0 dBSPL steps and left/
right keys for 0.1 dBSPL steps. The level 
range 80 - 140 dBSPL is supported.

• Confirm the setting with the enter key.
• Produce the specific reference signal 

with the calibrator onto the microphone.
• Press enter to execute the calibration, 

whilst the reference signal of the 
calibrator is still present.

• The frame WORKING ... followed by 
the frame CALIBRATION FINISHED! 
is shown centered on the calibration 
screen. 

• The new sensitivity is shown in mV/Pa.
• Enter the SPL/RTA mode and check the 

calibration by applying the reference 
signal again to the attached microphone. 
The sound pressure level of the 
calibrator shall be shown to confirm the 
calibration is carried out in good order.

In case of calibration problems various error 
indications may be displayed to inform the 
user about problems, such as caused by 
• to low or to high input level.
• the calculated sensitivity is out of the 

range 2 - 80 mV/Pa.
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Manual sensitivity setting
• Select the sensitivity value field, 
• Press enter and adjust the sensitivity 

using the up/down keys for 1.0 mV/Pa 
steps and left/right keys for 0.1 mV/Pa 
steps. The setting range 2 - 80 mV/Pa is 
supported.

• Press enter to confirm the setting.
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5.  MiniLINK PC Software
The MiniLINK PC software enables the transfer of stored measurements 
from the Acoustilyzer AL1 to the PC. Additionally the online data logging 
from the AL1 directly to the PC is supported

Installation

a. Start up the PC with Windows operating system (MiniLINK V3.00 or 
higher supports Windows 2000 + SP3, ME, XP, Vista, Win7 (32 & 64 
Bit).

b. Insert the enclosed MiniLINK CD into the CD drive. 

c. The MiniLINK software installation starts automatically. Follow the 
instructions on the screen.

 If the CD auto-start is disabled on the PC, follow the instructions below:

• Click on “Start → Run“ at the windows taskbar.

• Type “d:\setup“ (assuming “d“ is the letter of the CD drive) 

• Confirm with “ok“

 After completing the software installation, the MiniLINK CD shall remain 
in the CD drive for the next step.

d. Use the attached USB cable to connect the test instrument to the PC. 
Windows recognizes the new hardware component automatically and 
starts the hardware installation assistant.

e. Follow the instructions of the installation assistant. Please select the CD 
drive with the inserted MiniLINK CD as source for the USB driver when 
asked by the installation assistant.

 Note for 64 Bit / Windows 7 computers: Download the 64 bit driver from 
the website “http://registration.nti-audio.com/VersionCheck.php”. Then  
install the 64 bit driver as follows: Open the Device Manager menu, 
select USB port MiniLINK and update the driver by selecting the path of 
the previously stored 64 bit driver.

f. In case the warning messages “Digital signature not found”, “Do not 
install driver”, “not certified driver” or similar come up: Don’t listen to 
Microsoft, listen to us and continue with the installation.
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Start the MiniLINK PC Software

After the successful driver installation, the MiniLINK software can be 
started.

• To start the software follow the windows path “Start → Program → 
MiniLINK”. 

• The analyzer switches on automatically and the following screen is 
displayed on the monitor:

The test instrument is powered by the USB interface and therefore switches 
on by itself. During the operation with the connected USB interface the 
batteries should not be removed from the device.
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Free Registration of your Test Instrument

The Acoustilyzer includes additional “bonus features“, enabled after the 
registration of the test instrument at the NTI web site.

Overview of available bonus features:

 Instrument Function Display
AL1 Customized start-up screen

Online registration:
After the startup, the MiniLINK software automatically suggests the 
registration of non-registered connected instruments. The test instrument 
needs to be connected to the PC. Proceed with the automatic registration 
or alternatively select the MiniLINK menu “Help → Register“.

Offline	registration:
Register your device at “http://registration.nti-audio.com/Registration.php”. 
Key in your details and the serial number of the device. Read out the 
instrument serial number from your device by starting the instrument and 
keeping any button pressed. The start up screen remains displayed. The 
serial number starts with three letters (such as ANK675A0A2).

After successfully registering your device, you will receive an e-mail 
with your registration key within a few minutes. Please insert this key in 
the MiniLINK menu “Help → Register“. The test instrument needs to be 
connected to the PC.

http://registration.nti-audio.com/Registration.php
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Read Out of Stored Test Results

The analyzer memory is automatically transferred to the PC and visualized 
with small screenshots at the MiniLINK memory window.

Note: The MiniLINK memory window remains empty when no test 
results	are	stored	within	the	instrument.	Otherwise,	use	the	PC	
mouse	to	click	onto	the	“AL1	Memory“	tab	to	initiate	and	update	
the data memory window.

The test instrument display at the PC is synchronized to the actual LCD 
screen display of the connected audio analyzer. The title bar shows the 
serial number and firmware version of the test instrument.

Synchronized Display
MiniLINK PC 

Software Release 
Version

Firmware of 
connected audio 

analyzer

Serial Number of 
connected audio 

analyzer
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Visualizing the Test Results

All stored screenshots are shown in the MiniLINK tab “AL1 Memory“.

 

Stored screenshot incl. numerical results Stored data without screenshot

Arrows indicating additional 
numerical test results are stored 
together with this screenshot

Big view of screenshots
A double click on the screenshot will enlarge 
this screenshot. In this mode the menu 
allows printing, saving or copying of the 
screenshot or the numerical test results.

Any available numeric table is listed below 
the big view screenshot.
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Copying of Test Results and Screenshots

The displayed screenshots can directly be 
copied into reports for documentation.

• Select the menu “Edit → Copy Bitmap” 
to choose the graphics or select the 
menu “Edit → Copy Text” to choose the 
numerical measurement data

• Insert the clipboard into the reporting 
document with “Ctrl + V”, such as  
Excel, ...

Alternatively import the stored “*.txt” file, 
including the numerical measurement data, 
e.g. to Microsoft Excel by using the Excel 
import assistant.
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Example: Display of SPL/RTA test results

The SPL/RTA sound pressure level measurement provides the following 
test results:

• Test configuration

• Time, relative to logging start

• All relevant sound level parameters  
(please refer to section “SPL/RTA - Memory Functions” for details).
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Save Test Results & Screenshots

The displayed screenshots can be saved as bitmap files (*.bmp) and 
numeric data as text files (*.txt) to the hard drive. The file names consist of 
the first six device serial number digits and the screenshots name. 

For example the screenshot “A011_RT60” recorded e.g. with an  
Acoustilyzer S/N ANK675 is saved as 

• “ANK675_A011_RT60.bmp” & “ANK675_A011_RT60.txt”

This enables to store various test results of more audio analyzers on the 
same PC. Save the stored test results as follows:

• Select the screenshots to be saved in the memory field.

• Press the SAVE button or select in the menu “File → SAVE“.

• The menu below will be displayed. The directory path may differ 
according the installed Windows system.

• Select the SAVE/DELETE configuration and press SAVE.
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When saving the screenshots to the PC the same memorized values can 
be deleted at the test instrument automatically. Just select in the above 
displayed menu “Delete files in instrument memory after save” to empty the 
test instrument memory simultaneously.

Delete Test Results of Analyzer Memory

The memorized test results in the test instrument can be deleted as 
follows:

• Directly in the test instrument memory overview

• Select the screenshot in the MiniLINK memory screen and press 
DEL on the PC keyboard or using the delete function of the MiniLINK 
memory menu

• Selecting the delete function when saving the screenshots/test 
results to the PC

Test Result Logging at the PC

MiniLINK also allows the continuous logging of the Acoustilyzer test results 
online in customer defined time intervals. This test data is saved into the 
default log file software directly. At the end of the logging process, press 
the “SAVE” button to save and the data are saved under the file name e.g. 
“ANK675_PcLog_Level SPL”.

The logging function is ideally suited for long term monitoring or 
troubleshooting, e.g. in repair or broadcast applications.

Note:	 For	 sound	pressure	 logging	of	 specific	 events	 the	 tick	box	
“Reset Leq on Start” has to be enabled. This resets the device 
timer of the Acoustilyzer at the begin of the online logging and 
a new measurement is started automatically.
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icon for direct copying of 
present screenshot

To log online results, please:

• Select the requested measurement function at the test instrument

• Select the “Logging“ screen in the MiniLINK PC Software menu

• Select the required log time interval

• Press the “START” button to start the test result logging

• Press the “STOP” button to end the logging process

• Press the “SAVE” button to save the record to file

Additionally the present screenshot displayed on the MiniLINK PC software 
can be directly copied to file by pressing the marked icon with the mouse 
button. Paste the screenshot into any files by pressing “CTRL + V”.
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Remote Test Instrument Control with the PC

MiniLINK supports the remote control of the analyzer from a PC. Just click 
on the displayed test instrument and all keys can be operated with the 
below listed keys at the PC keyboard or using the mouse.

 

        

arrow keys & enter

Light: Ctrl + LESC

On/Off: Ctrl + P

 

“Shift ←” or “shift →” or the above indicated areas allow to change the 
screen selection of the enabled measurement function.

 

Click into these areas 
to change the screen 
selection 
(e.g. SPL ↔ RTA)
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MiniLINK Tools

The MiniLINK PC software includes many useful tools as follows:

• LCD Fullscreen

• Update Firmware

• Crossgrade Firmware

• StartUp Screen
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LCD Fullscreen

The actual test instrument display can be shown on the PC monitor in a full 
screen mode.

To enter the full screen mode: 
• Select the menu “Tools → FullScreen“ at MiniLINK 
 or click onto the  symbol.

To exit the full screen mode:

 • Press the “Q” button on the PC keyboard  
 or simply click into the screen with your PC mouse.

icon for large 
screen display
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Firmware Update

NTI provides free updates of the test instrument firmware and the MiniLINK 
PC software at the NTI website “www.nti-audio.com”. 

To check out any available online updates, follow these instructions:
• Connect your PC to the web & start the MiniLINK PC software
• Connect the instrument with the USB cable to the PC
• Select the menu “Help → Look for Updates“ at MiniLINK
• Follow the download instructions

Alternatively you can check for any new firmware and software releases at 
the web site “http://registration.nti-audio.com/VersionCheck.php”.

• Select the menu “Tools → Update Firmware“ at MiniLINK

Select the new firmware version in the displayed screen below:

for Minilyzer ML1:
ML1dA_V3.xx.bin

for Acoustilyzer:
AL1dA_A1.xx.bin

applicable firmware for 
the connected device 

After confirming the selected device firmware, the test instrument firmware 
is updated automatically. In case of any problems during the firmware 
upgrade, such as power failure, etc., the upgrade procedure can be 
repeated anytime.

Note: The	firmware	update	deletes	the	internal	device	memory.

http://registration.nti-audio.com/VersionCheck.php
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Firmware Crossgrade

The Acoustilyzer AL1 and the Minilyzer are based on the same hardware 
platform with different specific firmware installed. The available crossgrade 
packages allow to install the ML1 firmware into the AL1 or to install the AL1 
firmware into the ML1.

• Select the menu “Tools → Crossgrade Firmware“ at MiniLINK

Select the displayed firmware version in the screen below:

for Minilyzer ML1:
AL1dA_A1.xx.bin

for Acoustilyzer:
ML1dA_V3.xx.bin

applicable firmware for 
the connected device 

After confirming the selected device firmware, the crossgrade firmware 
is installed automatically within several seconds. The instrument displays 
UPDATING FIRMWARE.

Note:	 The	firmware	crossgrade	deletes	the	internal	device	memory,	
thus the customized start-up screen needs to be reloaded onto 
the instrument.
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Customizing the Startup Screen

The MiniLINK PC software supports the transfer of customized start-up 
screens to the test instruments. The personally defined start-up screen will 
be displayed instead of the factory logo every time the test instrument is 
switched on.

• Start the MiniLINK PC software

• Connect the instrument with the USB cable to the PC

• Select the menu “Tools → StartupScreen“ at MiniLINK

The following screen is displayed on the monitor:

The panel “Set Startup Screen” displays a sample default factory startup 
screen. The white center area (100 x 32 pixels) can be customized by the 
user. The remaining top & bottom gray area is fixed and cannot be altered.
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Guideline to define the new start-up screen:

• Use a pre-defined picture. The MiniLINK PC software will convert it 
to a 100x32 pixels black & white picture automatically. The following 
file types can be used as start-up screens: *.pcx;*.bmp;*.dic;*.rle;*.ico; 
*.wmf.

• Alternatively create a new start-up screen yourself using any picture / 
paint programs, such as “Microsoft Paint”. Set the file size to 100x32 
pixel and insert any text or graphics for the start-up screen. Save the file 
as “*.bmp* format.

• Press the button “Load Image” to select the file containing the new start 
up screen. 

• The start-up screen preview is displayed on the PC monitor.

• Press the button “Send to Device” to transfer the file to the device

• The audio analyzer is switching off and on automatically, so you can 
check out the new start-up screen by yourself immediately.

Sample start-up screens:
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Activate Options

The activate options menu is required for

• Activation of AL1 functionalities on your Minilyzer ML1 or the  
ML1 functionalities on your Acoustilyzer with the crossgrade 
package

• Activation of STI-PA measurement functionalities on the instrument

To activate one of the above functionalities

• Select the menu “Help → Activate Options“ at MiniLINK

• The following menu will be displayed

Follow the online activation instructions. Additionally detailed instructions 
are enclosed with the license number within the individual product 
package.
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6.  Troubleshooting

Numeric	data	import	of	“*.txt”	files	to	Excel

Problem:
The numbers are recognized as text only at the import of numeric test 
results to e.g. Microsoft Excel, so you cannot create tables or use the data 
for further calculations.

Solution:
The MiniLINK data files use the “.” as decimal separator. Therefore please 
set the decimal separator to “.” at the import procedure of these numeric 
test results into e.g. Microsoft Excel. 
Alternatively you can use copy → paste in the big view mode, select 
the menu “Edit → Copy Text” and paste the data into an open Excel 
document.

Factory Reset

To reset the instrument back to factory settings proceed as follows:

• Switch the unit off

• Press the ESC button and the On button at the same time for a few 
seconds

• The start-up screens shows up, reading in the bottom line “LOADING 
DEFAULT SETUP”

The instrument is now reset to factory conditions.
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7. Accessories
MiniSPL
The MiniSPL is the perfect accessory for 
acoustical measurements. Together with 
the Acoustilyzer AL1 a comprehensive 
integrating sound level meter is formed. 

The MiniSPL is a self contained omni 
directional 1/2" measuring microphone with 
built in impedance converter, pre-amplifier 
and power supply. It is battery powered and 
the XLR-output is balanced. The MiniSPL 
is classified as class 2 in accordance with  
IEC 61672 and is factory adjusted to a 
sensitivity of 20 mV/Pa.

STI-PA Measurement Option
The STI-PA analyzer option allows the 
reliable measurement of the speech 
transmission index according to the latest 
IEC standards within 15 sec. Besides the 
single value STI or CIS test result, a detailed 
view of the modulation indices and individual 
band level results is provided.

NTI	TalkBox
The TalkBox is the missing link for the 
complete evaluation of speech intelligibility 
in emergency life & safety announcement 
systems, from the talker’s microphone 
to the listener’s ear. The NTI TalkBox 
presents the standardized voice-like 
acoustical signal emission simulating a 
human talker according to IEC 60268-16, 
combined with a TNO certified speech 
intelligibility signal at standardized levels. 
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ML1 - AL1 Crossgrade
The ML1 - AL1 Crossgrade package enables 
to load the Minilyzer firmware onto your 
instrument, providing test functionalities, 
such as
• vu-PPM
• Balance
• THD 2nd - 5th 

harmonics
• Scope

• Frequency 
Sweep

• Time Sweep
• Induction Loop 

Mode

Adapter -20dB
The Adapter -20dB may be applied for 
balanced input levels higher than +20 dBu. 
This passive adapter extends the balanced 
input range of your Minilyzer/Acoustilyzer 
up to +40 dBu. The adapter is supplied with 
pin1-fuse for safe operation in combination 
with the USB interface MiniLINK.

Pouch
The soft pouch protects your Minstrument 
against shocks, dust and water. With its 
convenient belt-clip you can keep your 
Minstrument close to you even when you 
need both hands for other tasks.
Now available with a MiniSPL microphone 
holder, offering a space to store your mic.

Minstruments System Case
Store your valuable Minstruments test 
system consisting of the Minirator MR1, the 
Minilyzer ML1 or Acoustilyzer AL1 and the 
MiniSPL adequately in the compact system 
case which gives you extra space for cables, 
connectors and other accessories you may 
wish to bring along when you are ‘out in the 
fields’ checking audio systems.
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8.	 Technical	Specification
Measurements

• Sound Pressure Level
• Real Time Analyzer
• Zoom FFT
• Reverberation Time
• Delay Time
• Level RMS, Distortion THD+N
• Frequency
• Polarity Test
• Speech Intelligibility STI-PA (optional)

Sound Pressure Level
 • SPL, Leq, Lc peak, Lmin, Lmax acc. IEC 61672
 • Timer for single and repeated measurements 

• Dynamic range (using MiniSPL): 30 - 130 dBSPLA 
• Filters: Flat, A, C, X-Curve-1, RLB (Broadcast Loudness) 
• Logging of SPL/RTA results into AL1 memory 
• Wideband- and RTA values simultaneously available

Real Time Analyzer 
 • 1/3 or full octave band resolution, class 0 filters 

• SPL, LEQ and Max-Min display per band

Reverberation Time
 • 1/1 Octave band resolution, 63 Hz - 8 kHz, 
  based on T20 results, according to ISO3382
 • 1/3 Octave band resolution with post processing
 • Automatic averaging with individual result readout and storage 

• Source signal: Gated pink noise (from Test-CD or Minirator)

Zoom FFT
 • Real-time Zoom FFT with 50% overlapping, 93 Bins 

• Frequency Range: 10 Hz - 20 kHz 
• Resolution: 187.5 Hz to 0.73 Hz

Delay Time
 • Propagation delay between electrical and acoustical signal  

 input using built-in mic. Resolution < 0.1ms, max time: 1 s 
• Dedicated test signal: NTI chirp (from Test-CD or Minirator)
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Polarity Test
 • Positive / Negative detection through internal microphone or   

 XLR RCA connector
. • Checks polarity of midrange-speakers, woofers, sub-woofers   

 and cables.
 • Down to 10 dB S/N ratio of input signal.
 • Testsignal: NTI Polarity Signal (AL1 Test CD oder Minirator)

Electrical 
 • Level RMS, THD+N, Frequency, Polarity
 • Filters: Flat, A-weighting, C-weighting, Highpass 400 Hz,  

 Highpass 19 kHz 

STI-PA (Option)
 • Single value STI and CIS test result. Modulation indices  

 and individual band level results accessible. Error indicator.
 • Fulfills the IEC 60268-16 release 2003 standard 
  (including amplitude weighting) 

• TNO verified algorithm

Frequency
 • Range 10 Hz to 20 kHz
 • Resolution 4 digits
 • Accuracy < ± 0.1 %

Level
 • Units dBu, dBV, VRMS
 • Resolution 3 digits (dB-scale) or 4 digits (V-scale)
 • Accuracy ± 0.5 % @ 1 kHz
 • Bandwidth 20 Hz to 20 kHz
 • Flatness ± 0.1 dB

THD+N	(Total	Harmonic	Distortion	+	Noise)
 • Bandwidth 10 Hz to 20 kHz
 • Resolution 3 digits (dB-scale) or 4 digits (%-scale)
 • Residual  balanced  < -85 dB @ -10 dBu to +20 dBu
  THD+N unbalanced  < -74 dB @ 0 dBu to +14 dBu

PC Interface
 • Interneral device memory for up to 580 records 
 • USB interface to MiniLINK PC software 
 • Online data logging from Acoustilyzer directly to PC 
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Input Connectors 
• XLR balanced, RCA unbalanced

Input Impedance 
• 40 kOhm balanced, 20 kOhm unbalanced

Input RMS ( upper measurement limit )   
 • balanced +20 dBu (7.75 VRMS)
 • unbalanced +14 dBu (3.8 VRMS) 

• for input levels > 20 dBu (balanced) the Adapter -20 dB is
  available as accessory

Max. DC Input 
• ± 50 VDC

Residual Noise 
• < 12 μV, XLR-input shorted

Internal Microphone (for Polarity and Delay measurement only)
 • Omni directional

Monitor Output 
• Jack 3.5 mm (1/8“), suitable for all common headsets

Display Graphic LCD 64 x 100 pixel, with backlight

Batteries 
• 3x AA batteries (alkaline) 
• Typical battery lifetime > 16 hrs

Dimensions	(L	x	W	x	H)
 • 163 x 86 x 42 mm (6.4“ x 3.38“ x 1.63“)

Weight 
• 300 g (10.5 oz) incl. batteries

Temperature 
• 0° to +45° C (32° to 113° F)

Humidity 
< 90 % R.H., non condensing
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9. Appendix: Introduction to STI-PA

Application:
In case of emergency, public address systems in buildings like airports, 
railway stations, shopping centers or concert halls have to (clearly) 
inform persons in danger about escape information and directions. 
However if such announcements are misunderstood due to poor system 
quality, tragic consequences may result. Therefore, it is essential 
to design, install and verify sound reinforcement systems properly 
for intelligibility. In addition, a variety of other applications such as 
legal and medical applications may require intelligibility verification. 

Standard:
The IEC 60849 standard (national standards - see table) requires the 
verification of electro acoustic sound systems for emergency purposes to 
ascertain a minimum level of speech intelligibility in case of an emergency 
under realistic circumstances. Thereby, speech intelligibility from a 
regulatory view is not a subjective measurement, but can be verified with 
several, more or less complex methods that have been standardized in IEC 
60268-16.

National standards:
• IEC 60849 Sound systems for emergency purposes (also VDE 0828 

part 1 and DIN-EN, BS-EN, SN-EN, OEVE-EN, …) 
• NFPA 72 National Fire Alarm Code 2002 (2002 edition, section 7.4.1.4) 
• BS 5839-8 Fire detection and alarm systems for buildings. Code 

of practice for the design, installation and servicing of voice alarm 
systems 

Subjective Testing Methods:
Although frequency response, distortion or loudness all are important 
to intelligibility, conventional measurements of these same parameters 
together only marginally relate to intelligibility. When added issues such as 
directionality of drivers and the environment are taken into consideration, 
the question then is how well a spoken message can be understood at 
different locations.
 
One approach is to let a trained human speaker read a number of 
existing or synthetic words, whereas a representative number of listeners 
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individually write down what they believe of having understood. The 
statistical analysis of these notes results in a value representing the 
percentage of the listeners who have understood the messages correctly. 
 
Important procedures according to this method are PB-words, CVC or SRT 
(Speech Reception Threshold). However, conducting such tests is rather 
costly, and in some hazardous locations, even impossible. Therefore, 
these methods are mainly used to verify technical principles during 
development.

Technical Methods:
Already back in 1940, Bell Laboratories started to develop measurement 
technologies to determine the speech intelligibility. Nowadays, highly 
developed algorithms as SII (Speech Intelligibility Index) and various 
forms of the STI (Speech Transmission Index) allow measuring speech 
intelligibility. These techniques take care of many parameters which are 
important for intelligibility such as:

• Speech level

• Background noise level

• Reflections

• Reverberation

• Psycho acoustic effects (masking effects) 

Measurement techniques use synthesized test signals that don’t sound like 
speech, but which have many common characteristics to real speech signals. 
The averaged frequency response, as well as low frequency modulation, 
is based on human speech. Since the speech of men’s and women’s 
voices sound different, some measurement techniques use separate male 
and female test signals: Speech intelligibility measurements acquire and 
evaluate the signals in a manner characteristic of the way human speech is 
altered before reaching the ears of a listener. Extensive investigations have 
shown the relationship between the alteration of speech characteristics and 
the resulting speech intelligibility. These findings are incorporated into the 
speech intelligibility meter that is able to display the intelligibility result as 
a single number between 0 (unintelligible) and 1 (excellent intelligibility). 
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STI,	RASTI	or	STI-PA

STI, RASTI or STI-PA are the most established methods for measuring 
speech intelligibility. All three of them basically apply the same principle, 
whereby RASTI and STI-PA are a simplified version of STI. This article 
explains the principles behind these methods.

Speech Model:

First of all, measuring the speech intelligibility requires a model for speech 
signals. For instance, speech may be described as superposition of various 
phoneme frequencies that are modulated (i.e. of which the amplitude is 
varied).
Frequency Spectrum:
The frequency analysis of a male voice 
over a certain period results in a typical 
characteristic as shown in Figure 1. 

 
Fig. 1: Averaged octave 
band spectrum of a male 
speaker.

Time Modulations:
Within each frequency band, the signal 
level varies, i.e. it is “modulated” by the 
speaker. Figure 2 shows the envelope of a 
speech signal in the 250 Hz band, whereby 
the shape of the envelope is given by the 
speech contents.
By analyzing the spectra of envelope 
sequences it can be shown that a speaker 
modulates the individual frequency bands in 
the range from 0.2 to 12.5 Hz.

 
Fig. 2: Envelope of a speech 
signal (250 Hz band). 

 
Fig. 3: frequency spectrum 
of the envelope of a speech 
signal (250 Hz band).
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Modulation Transfer Function (MTF)

For a high speech intelligibility it is mandatory that the integrity of the 
modulations of the transmitted voice signal be preserved. Therefore, the 
three core intelligibility measurement methods, STI, RASTI und STI-PA are 
based on measuring the MTF (Modulation Transfer Function). This function 
quantifies the degree to which the voice modulations are preserved in the 
individual frequency bands.

The envelope shown in Figure 3 is divided into 1/3rd octave band 
frequencies, thus resulting in 14 frequency bands between 0.63 and 12.5 
Hz. The modulation transfer function determines for each of the 7 voice 
bands (refer to Figure 1) how well the modulations are preserved.

Based on the MTF results as well as further parameters such as the 
sound pressure level, hearing threshold, frequency response or psycho 
acoustic effects (masking effects) it becomes possible to reliably determine 
the speech intelligibility. The corresponding calculations, which are 
optimized continuously, are based on extensive and profound evaluations 
and comparisons with subjective methods. Measuring the complete 
MTF – as required for STI – can become rather complex. For instance,  
14 * 7 = 98 individual measurements must be executed, thus resulting in 
a total acquisition duration of 15 minutes. Therefore, different approaches 
have been developed to reduce the test period and to enable speech 
intelligibility measurements with portable instruments.
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STI - Speech Transmission Index

The STI result is based on the complete set of 98 measurements. Since 
this approach requires a rather long test period, it is less frequently applied 
in practice. However, STI represents the most detailed method to measure 
the speech intelligibility and is mostly used if alternative approaches do not 
provide reliable results due to unfavorable environmental conditions.
In practice, the STI result is preferably calculated out of the impulse 
response (MLSA) that has been acquired e.g. with a PC-based system. 
This approach is much quicker, but requires a lot of experience and 
especially a linear behavior of the setup, i.e. there must be no non-linear 
processing or conditions, including compressors or limiters, which is a 
rather rare situation.

RASTI - Room Acoustics Speech Transmission Index

RASTI acquires only few segments of a complete MTF, which at first glance 
obviously represents an extreme simplification of STI. Therefore, tight use 
restrictions must be met to acquire reliable speech intelligibility results with 
RASTI. Furthermore, the RASTI result does not consider significant and 
practical auxiliary parameters such as the frequency response, echoes or 
frequency-dependant reverberation times.

For a RASTI measurement, only two simultaneously generated frequency 
bands are considered, i.e. the 500 Hz and the 2 kHz band which then are 
modulated with four and five frequencies respectively.
The practical application of RASTI is mainly restricted to acquisitions 
between two persons. However, RASTI used to be the only method to 
measure the speech intelligibility with a portable instrument for a long time
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STI-PA - Speech Transmission Index for Public Address Systems

A rising awareness for security issues, new technological means and the 
shortcomings of RASTI triggered the speaker manufacturer Bose and the 
research institute TNO to develop a new method for speech intelligibility 
measurements of PA installations. The result of these efforts is STI-PA, 
which allows quick and accurate tests with portable instruments.

Like RASTI, STI-PA applies a simplified procedure to calculate the MTF. 
But STI-PA determines the MTF by analyzing all seven frequency bands, 
whereby each band is modulated with two frequencies.
Supposing that no severe impulsive background noise is present and 
that no massive non-linear distortions occur, STI-PA provides results as 
accurate as STI. If however impulsive background noise is present during 
the normal system operation hours, it is usually possible to mitigate the 
effects by also acquiring a measurement at a more favorable time e.g. 
under slightly different conditions in the area, or during the night time - and 
to calculate an unbiased overall measurement by using the results of both 
test cycles.

NTI STI-PA measurement table:

Portable STI-PA analyzers, e.g. NTI’s Acoustilyzer, are able to evaluate 
speech intelligibility within 15 seconds per position and are thus well suited 
for wide-area measurements and high productivity.

Read more on the web site “www.nti-audio.com”

http://www.nt-instruments.com/acoustilyzer
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